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Integration Note

Manufacturer: Trane 

Model Number(s): TZEMT400BB32MAA Thermostats / Leviton 
VRC0P-1LW (+3) RS-232 Adapter 

Minimum Core Module Version:: 5.8 
Document Revision Date: 2/18/2013 

OVERVIEW AND SUPPORTED FEATURES 
The Trane TZEMT400BB32MAA thermostats are wireless Z-Wave thermostats capable of controlling 
single and multi-staged forced air gas, oil, electric, and heat pump and air conditioning systems.  The 
TZEMT400BB32MAA thermostats are remote controllable over Z-Wave 900mhz wireless mesh networks 
via the use of a Z-Wave RS-232 adapter, enabling 2-way control and feedback from g!.  The g! system 
supports up to 16 wireless thermostats. 

Note: Z-Wave RF operates at 900MHz.  Any other devices operating on the same frequency may cause 
interference and need to be removed.  Leviton recommends the system in installations of 7500 square 
feet or less and installing devices typically no more than 30 feet apart.  Please refer to the Leviton Vizia 
RF Systems Guide (www.ViziaRF.com) for other installation considerations and details on proper setup 
of the Z-Wave networks.  Additional information can be found at www.z-wave.com. 

THE TZEMT400BB32MAA DRIVER SUPPORTS THE FOLLOWING FEATURES: 

Auto Discovery: Thermostats may be auto-detected and added into g! 

History View: The history view shows the inside temperature, outside temperature, unit run times, and 
cooling and heating setpoints. 

Mode Control: The climate system can be set to run in the following heating and cooling modes: Heat 
only, Cool only, Auto, Off or EHeat (Heat Pump Only).  Fan Modes: On, Auto, Circulate 

Note: Circulate must be enabled on the thermostat. 

Remote Sensors: The TZEMT400BB32MAA thermostat driver supports remote sensors in the Internal 
Sensor mode only. 

Schedule Control: Scheduling is supported from the Viewer.  The TZEMT400BB32MAA Built-in 
Schedule must be disabled to use g! scheduling. 

Shared Z-Wave Network: A single Leviton Vizia RF Z-Wave network may contain Door Locks, 
Thermostats, and Lights.  All three may be controlled over a single RS-232 Z-Wave adapter.  See the 
appropriate Z-Wave Door Lock and Z-Wave Lighting Integration Notes for details. 

Temperature Control: Temperature control can be managed by schedules tied to house modes or by 
manual control based on time (Timed Temporary Hold, Temporary Hold and Permanent Hold). 

THE TZEMT400BB32MAA DRIVER DOES NOT SUPPORT THE FOLLOWING FEATURES: 

Any feature not specifically noted as “supported” is not supported. 

Name Detection: All thermostats will populate during auto-discovery with their Z-Wave node number as 
their name.  Thermostat names do not read into g! at this time. 

Decimal Temperature Control: TZEMT400BB32MAA thermostats do not support decimal temperature 
set points. 
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INSTALLATION OVERVIEW 
1. Install the TZEMT400BB32MAA thermostats and wire HVAC according to standard Trane 

TZEMT400BB32MAA documentation. 

2. Test the thermostat and climate system to ensure that the thermostats correctly turn on the 
appropriate heating or cooling equipment, and open or close the appropriate valves / dampers. 

3. Install a Leviton VRC0P-1LW (+3) RS-232 Z-Wave adapter in a location convenient for both a serial 
run to the g! Controller and within range of other Z-Wave devices. 

Note: Be sure that the “+3” notation is present on the back of the VRC0P-1LW.  (See the Leviton 
application note for additional information: http://communities.leviton.com/docs/DOC-2392). 

4. Run a Cat-5 or serial cable to the location of the Z-Wave RS-232 location. 

5. Using a Primary Controller, such as a programming remote (ex. Leviton VRCPG), ControlThink’s 
ThinkEssentials or Leviton’s Vizia RF+ Installer Tool (v1.1.0.0) create a Z-Wave network and add 
thermostats and the RS-232 adapter according to standard procedures. 

Important!  Disconnect the g! system from the VRC0P controller when any Z-Wave network 
configuration is occurring. 

6. Connect the Serial Cabling to the Z-Wave RS-232 adapter electrically.  See the wiring diagrams. 

7. Configure g! for the thermostats and confirm communication between the thermostats and the g! 
Controller. 

8. Test the system by changing the set points, modes and schedules on the viewer and various 
thermostats, confirming that the various components in the system respond as expected. 

 

Z-WAVE REPEATERS 

Many Z-Wave devices function as repeaters, meaning an incoming signal can be passed to another Z-
Wave device within range.  The maximum distance a signal can be sent from one Z-Wave device to 
another varies depending on the brand/model of the device used.  See the manufacturer’s 
documentation for the devices you intend to use for specifics. 

The signal can be extended from the controller to the device being controlled by a maximum of four 
passes, known as “hops.”  (From the controller to the first device, the first device to the second, the 
second device to the third and from the third device to the one actually being sent the signal.) 

Depending on the network configuration, occasionally it may be necessary to manually program the 
“hops” to optimize reliability.  Refer to the documentation that came with your specific programming 
tool for details. 

Note: Because Z-Wave door locks require repeaters that are “beaming-compatible” and that support 
beaming of encrypted signals we recommend using only repeaters (lamp modules, switches, etc.) that 
support these features if door locks will be a part of the installation.  See the manufacturer’s 
documentation for the devices you intend to use for specifics. 

  

NOTES REGARDING THE TRACKING OF Z-WAVE DEVICES: 
In general g! keeps track of the states of all of the Z-Wave Network Devices; however there is latency in 
the reporting back of the devices from the Z-Wave network.  The result is that g! updates its states as the 
devices report back.  This is evident when watching the viewer interface after a change is made at the 
device.  The viewer controls will update sequentially over a few seconds (or more on larger systems) as 
the devices report their states. 
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CONNECTION DIAGRAMS 

HC Controller
RS-232 Port

6
5 Cat5 Cable

4 DB9M to RJ45 Adapter

3 DB9 to RJ11 Cable

2 Leviton Z-Wave RS-232 Adapter

1 Thermostats

Z-Wave Signals

7 Z-Wave Repeating Module

 
BILL OF MATERIALS  

Device Manufacturer Part Number Protocol Connector Type Notes
1 Thermostat Trane TZEMT400BB32MAA Z‐Wave RF
2  Z‐Wave RS‐232Adapter Leviton VRC0P‐1LW (+3) RS‐232/Z‐Wave RJ‐11 Female
3 RJ‐11 to DB9 Cable Leviton N/A RS‐232  RJ‐11 Male / DB9 Female Included w/ VRC0P+3
4 DB9 to RJ‐45 Adapter ELAN HA‐CB‐307 RJ‐45 Female x DB9 Male
5 Cat5 Cable Assembly Installer N/A RS‐232 RJ‐45Male x RJ‐45 Male Must terminate all 8 conductors
6 Controller ELAN HCxx RS‐232 RJ‐45 Female Use Comm port 1, 2, 3, etc.
7 Z‐Wave Repeating Module Various Various Z‐Wave RF Beaming and Encrypted Signal Support Recommended

Programming Remote Leviton VRCPG‐BSG Z‐Wave RF Not Shown ‐ Needed to set up Z‐Wave Network
OR
ControlThink's ThinkEssentials Leviton CTZUS‐1US Z‐Wave RF Not Shown ‐ Needed to set up Z‐Wave Network
OR
Vizia RF+ Installer Tool Leviton VRUSB‐1US Z‐Wave RF Not Shown ‐ Needed to set up Z‐Wave Network

8

 

Note: Update the VRC0P-1LW (+3) to the latest firmware prior to creating the Z-Wave network.  Updates 
are found on the Leviton web site. 
http://www.leviton.com/OA_HTML/SectionDisplay.jsp?section=42159&minisite=10251 

 
Minimum Version: $Leviton(C) 2008 V2.33S/Z-Wave 3.11 
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Z-WAVE NETWORK PROGRAMMING 
 
Program the Z-Wave according to standard procedures.  Regardless of device function, the basic setup 
of Z-Wave networks is the same.  Various limitations may be imposed based on the programming tool 
used.  Refer to the documentation that came with your specific programming tool for details. 
 
Typically a Z-Wave network is programmed using its Programmer/Remote Control (such as the Leviton 
VRCPG-BSG remote, ThinkEssentials Software or Vizia RF+ Installer Tool) to enroll / include devices in 
the Z-Wave Network.  The methods for using the VRCPG, ThinkEssentials and Vizia RF+ Installer Tool 
are detailed below.  Note that these instructions assume you are familiar with Z-Wave programming 
concepts.  If you require further detail or clarification, you may wish to see Leviton Vizia RF 
(www.ViziaRF.com), or Trane TZEMT400BB32MAA documentation / technical support for assistance. 
 
Note: Programming using the Leviton VRCPG-BSG Remote is NOT supported for thermostats when Z-
Wave locks are to be included in the system 
 
While the VRCPG-BSG does allow you to enroll locks in a Z-Wave network it does not allow you to 
associate the locks with the VRC0P module. 
 
PROGRAMMING USING THE LEVITON VRCPG-BSG REMOTE: 
Setup steps below are created using a VRCPG-BSG remote.  Your steps may vary somewhat if your 
remote model differs, but the basic process should be the same. 

1. Confirm all devices are at factory default and have not been setup in any Z-Wave Network. 

2. To include the TZEMT400BB32MAA thermostats in the network: 

a. Start up the Leviton Remote and begin the Installation Checklist. 

i. Perform Step 1 of the Installation Checklist, Include Dimmers/Switches, and 
include the first thermostat in the network. 

ii. When prompted by the remote, on the TZEMT400BB32MAA thermostat: 

1. Press the Menu button. 

2. Navigate to and select the Z-Wave Install menu option. 

3. At the “Add Thermostat to Z-Wave Network” prompt select Yes. 

Note: It is best practice to give the thermostat a descriptive name when prompted, like Master Bedroom, 
for future reference.  Note that this name is not saved in the thermostat and will not be automatically read 
into g!  You should keep notes of the location of each thermostat and their Node IDs, as the only 
identification available to g! is the Node ID. 

3. Repeat Step 2 for each additional TZEMT400BB32MAA to be added to the network. 

4. To include the VRC0P-1LW (+3) in the network: 

a. Set the VRC0P-1LW to programming mode by pressing and holding the button (clear tab 
on face of unit) until the light blinks amber. 

b. Perform Step 2 of the Installation Checklist, Include Controller, to include all Controllers 
into the network.  Controllers include the RS-232 interface module (VRC0P-1LW (+3)). 

5. Perform Step 3 of the Installation Checklist, Update Controller, to update all of the controllers 
following the inclusion of all devices. This will create the proper mapping between devices. 

6. In a thermostat only network, you may skip Step 4 (Create Areas) and go to Step 5 (Set 
Associations) of the Installation Checklist. 

7. Perform Step 5 of the Install Checklist, Set Associations, to associate each thermostat with the 
controller. 
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8. You may complete or skip Step 6 (Security) of the Installation Checklist as desired. 

9. Choose Step 7 of the Installation Checklist, Install Complete. 

10. Test all devices for proper operation.  From the Main Menu of the VRCPG remote you should be 
able to select Thermostats and get current temperature data and change modes (heat, cool etc) for each 
thermostat on your network. 

 

PROGRAMMING USING THINKESSENTIALS AND USB Z-WAVE ADAPTER: 

Setup steps below are created from version 2.5 of ThinkEssentials.  If you are running a different version, 
your steps may be somewhat different than below, but the basic process is the same. 

1. Confirm all devices are at factory default and have not been setup in any Z-Wave Network. 

2. Either create a New Network or Open an Existing Network file. 

3. To include the TZEMT400BB32MAA thermostats in the network: 

a. In the ThinkEssentials software, from the Design Tab select the Add Device button. 

b. On the TZEMT400BB32MAA thermostat: 

1. Press the Menu button. 

2. Navigate to and select the Z-Wave Install menu option. 

3. At the “Add Thermostat to Z-Wave Network” prompt select Yes. 

4. Repeat Step 3 for each additional TZEMT400BB32MAA to be added to the network. 

5. To include the VRC0P-1LW in the network: 

a. Set the VRC0P-1LW (+3) to programming mode by pressing and holding the button 
(clear tab on face of unit) until the light blinks amber. 

b. In the ThinkEssentials software, from the Design Tab select the Add Device button.  
The software will confirm the VRC0P-1LW has been included in the network and its icon 
will be displayed in the Design Tab.  The software will automatically assign a Node ID 
during this process. 

Note: It is best practice to give the thermostat a descriptive name when prompted, like Master Bedroom, 
for future reference.  Note that this name is not saved in the thermostat and will not be automatically read 
into g!  You should keep notes of the location of each thermostat and their Node IDs, as the only 
identification available to g! is the Node ID. 
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6. Associate each thermostat to the Controller. 

a. Move to within three feet of the thermostat. 

b. Right-click on the Thermostat icon and select “Properties”; in the lower right-hand corner 
of the display, the status message “Loading status from the device” appears; wait until 
the status message changes to “Done loading status.” 

c. Switch to the “Device Associations” tab. 

d. Select “Button #1” in the drop down menu. 

e. Press the “Edit” button – a pop up appears. 

f. Left-click on the Controller icon to make the association, then click on “Done” in the pop 
up. 

7. Test all devices for proper operation.  From the Design Tab you should be able to right-click on 
each thermostat and choose Advanced Thermostat Options to see current temperature data 
and change modes (heat, cool, etc.) for each thermostat on your network. 

 

PROGRAMMING USING LEVITON’S VIZIA RF+ INSTALLER TOOL (V1.1.0.0) AND USB Z-WAVE ADAPTER: 

Setup steps below are created from version 1.1.0.0 of the Vizia RF+ Installer Tool.  If you are running a 
different version, your steps may be somewhat different than below, but the basic process is the same. 

1. Confirm all devices to be added are at factory default and have not been setup in any Z-
Wave Network. 

2. Either create a New Network or Open an Existing Network file. 

3. To include the TZEMT400BB32MAA thermostats in the network: 

a. In the Vizia RF+ software select the Include Device button. 

b. On the TZEMT400BB32MAA thermostat: 

i. Press the Menu button. 

ii. Navigate to and select the Z-Wave Install menu option. 

iii. At the “Add Thermostat to Z-Wave Network” prompt select Yes. 

4. Repeat Step 3 for each additional TZEMT400BB32MAA to be added to the network. 

5. To include the VRC0P-1LW (+3) in the network: 

a. Set the VRC0P-1LW to programming mode by pressing and holding the button (clear tab 
on face of unit) until the light blinks amber. 

b. In the Vizia RF+ software select the Include Device button.  The software will confirm 
the VRC0P-1LW has been included in the network and it will be displayed in the All 
Devices node of the programming tree.  The software will automatically assign a Node ID 
during this process. 

Note: It is best practice to give the thermostat a descriptive name when prompted, like Master Bedroom, 
for future reference.  Note that this name is not saved in the thermostat and will not be automatically read 
into g!  You should keep notes of the location of each thermostat and their Node IDs, as the only 
identification available to g! is the Node ID. 
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6. Associate each thermostat to the Controller. 

a. In the Vizia RF+ software right click on the VRC0P module under All Devices in the 
programming tree. 

b. Select RS-232 Setup from the menu. 

c. In the LevSerialInterfaceConfig dialog box: 

i. Verify that the RS-232 Module drop down shows that the VRC0P module is 
selected. 

ii. Check the box for each thermostat Node ID to be associated to the VRC0P 
module. 

iii. Click the Set Association button. 

iv. Close the dialog box. 

7. Test all devices for proper operation.  Select each thermostat from the All Devices node of the 
programming tree and change modes (heat, cool, fan, etc.) for each thermostat on your network.
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g! CONFIGURATION DETAILS 
The following table provides settings used in the g! Configurator when connecting to a Z-Wave thermostat network.  Please refer to the Configurator 
Reference Guide for more details. 

In the table below: 

o “<Select>”    Select the appropriate item from the list (or drop-down) in the Configurator. 

o “<User Defined>”, etc.   Type in the desired name for the item. 

o “<Auto Detect>”, etc.   The system will auto detect this variable. 

Devices Variable Name Setting

Communication Device Name <User Defined> (Default: New Device)
Type Serial Port
Communication Type Leviton Z‐Wave RS‐232 Network
Location <User Defined> (Not Required)
Comm Port <Select>

HVAC Units Name <User Defined>
Model Generic HVAC Unit
Controls Heat <Select from list>
Controls Cooling <Select from list>
Controls Fan <Select from list>

<Discover Devices>

Thermostats Name  
Location <User Defined> (Not Required)
Comm Device <Auto Detect>
Thermostat # <Auto Detect>
Settings <Select from list>
Heating Unit <Select from list>
Cooling Unit <Select from list>

Schedules

Global Options Units <Select from list>
Temporary Hold Mode <Select from list>
Temporay Hold Default Time <Select>
Outside Temperature Sensor <Select from list>
Outside Humidity Sensor <Select from list> Choose Optional sensor if installed or choose internet

Fahrenheit or Celsius

Choose Optional sensor if installed or choose internet

Timed Hold or Hold until next schedule period

Use to Enable/Disable Fan Circulate and Emergeny Heat buttons on Viewers

Set to YES if controlling Cooling

Comments

Set to YES if controlling Heat

Com 1, 2, 3 etc.

Set to YES if controlling Fan

Discover Devices will set a Default name of "Z‐Wave Thermostat #1, #2", etc.

Set up HVAC Schedules Under Each T‐Stat

Click the Discover Devices button on the Communication Device
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TESTING THE Z-WAVE SYSTEM 
On occasion it may be necessary to test the Z-Wave system “outside” of the g! interface to verify 
communication between the thermostats and the controller (the VRC0P-1LW).  The following steps are 
intended to provide a method to test the basic communication status of the Z-Wave network. 

1. Complete your Z-Wave network set-up as described above, ensuring all thermostats and 
controllers have been added to the network. 

2. Connect a serial cable from your computer to the VRC0P-1LW’s RJ-11 to DB9 cable.  Use a USB 
to Serial adapter if required. 

3. Set up a terminal program (ex: HyperTerminal) with the following settings: 

a. 9600 baud; 8 data bits; No parity; 1 stop bit; Flow Control – None 

b. ASCII Sending Set Up 

i. Send line ends with line feeds 

ii. Echo typed characters locally 

4. Send test commands to verify correct operation: 

Note: Terminal programs other than HyperTerminal may display differently.  The important thing 
is that the “<E000” displays, indicating a correctly formatted command was entered.  The 
“<X000” indicates that the VRC0P module communicated correctly with the thermostat. 

a. To set a thermostat to OFF: 

i. In HyperTerminal type:  >NxSE64,1,0 where “x” is the Node ID of the thermostat 
being controlled and press Enter. 

1. Feedback in HyperTerminal should be <E000 followed on the next line 
by <X000 and then <E000 on the third line. 

2. The selected thermostat shows that it is OFF. 

b. To set a thermostat to HEAT: 

i. In HyperTerminal type:  >NxSE64,1,1 where “x” is the Node ID of the thermostat 
being controlled and press Enter. 

1. Feedback in HyperTerminal should be <E000 followed on the next line 
by <X000 and then <E000 on the third line. 

2. The selected thermostat shows that it is set to HEAT. 

c. To set a thermostat to COOL: 

i. In HyperTerminal type:  >NxSE64,1,2 where “x” is the Node ID of the thermostat 
being controlled and press Enter. 

1. Feedback in HyperTerminal should be <E000 followed on the next line 
by <X000 and then <E000 on the third line. 

2. The selected thermostat shows that it is set to COOL. 
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d. To query the STATUS of a thermostat: 

i. In HyperTerminal type:  >NxSE64,2 where “x” is the Node ID of the thermostat 
being controlled. 

1. Feedback in HyperTerminal should be <E000 followed on the next line 
by <X000 and then <E000 on the third line.  The fourth line should be 
Nxxx:064,003,yyy where “xxx” is the Node ID of the thermostat (single 
and double digit Node IDs will have leading zeros) and “yyy” is the status 
of the thermostat. 

a. 000 = OFF 

b. 001 = HEAT 

c. 002 = COOL 

 

If you receive feedback where E000 (as noted above) is something different it indicates that the 
command was not entered correctly. 

If you receive feedback where X000 (as noted above) is something different it indicates that the VRC0P is 
not communicating correctly with the thermostat. 

Correct any problems prior to integrating with the g! system.  Contact the manufacturer(s) of the 
product(s) you are installing for additional help with troubleshooting your Z-Wave network. 

 

 

COMMON MISTAKES 
1. Improper Z-Wave setup.  Ensure that you fully program and test your Z-Wave network for proper 

operation prior to integration with g! 

2. Placing the Z-Wave RS-232 Adapter out of range of other Z-Wave devices.  Z-Wave devices create a 
wireless, self-healing mesh network, and should be placed where they are in range to communicate 
with multiple other devices for best results. 

3. Adding thermostats / repeaters to the network after adding controllers.  If thermostats / repeaters are 
added after controllers the controllers must be updated. 

4. Using a VRC0P-1LW that does not have the (+3) notation. 

5. Failing to update the VRC0P-1LW firmware.  Minimum Version: $Leviton(C) 2008 V2.33S/Z-Wave 
3.11 

6. Failing to Disable thermostat schedule when using g! schedule. 

7. Enabling / Disabling Fan Circulate (Cycle) or Emergency Heat (Heat Pumps Only) on the thermostats 
but setting incorrectly in Configurator and vice versa. 
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Z-Wave Thermostat Comparison Chart 

Model 

Feature 

Auto 
Mode 

Fan 
Modes 

Remote 
Sensor 

Decimal 
Temperature 

Unsolicited 
Feedback 

Green / Energy 
Save Mode* 

Built-In 
Schedule 

2GIG No On / Auto No Yes4 No No6 Yes8 

Honeywell Yes1 On / Auto 
/ Circulate No Yes5 Yes No Yes8 

RCS Yes On / Auto 
/ Cycle2 Yes3 No Yes Yes7 Yes9 

Trane Yes On / Auto 
/ Cycle2 No No Yes Yes7 Yes8 

Wayne Dalton No On / Auto No No No Yes7 No 

 

* See information on the following page. 

1. Can be enabled.  

2. Cycle must be enabled in thermostat programming. 

3. Temperature only. 

4. Feedback to .5° Celsius and Fahrenheit. 

5. Feedback to .5° Celsius. 

6. When Z-Wave is activated the “Save Energy” button on the thermostat is disabled. 

7. Activated by selecting on thermostat. 

a. RCS – Set to AWAY mode on the thermostat. 

b. Trane – Select Energy Saving Mode on the thermostat. 

c. Wayne Dalton – Press the Save Energy button on the thermostat. 

8. Can be enabled.  (Factory default is disabled.) 

9. Can be disabled.  (Factory default is enabled.) 
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*GREEN / ENERGY SAVE MODE 
This feature functions as follows: 

When the user enters the “Green / Energy Save” mode: 

1) The thermostat switches to a second “energy saving” set point. 

2) g! puts the thermostat into “Permanent Hold” mode. 

 

When the user returns to “Normal” mode: 

1) The thermostat goes back to the normal set point. 

2) g! puts the thermostat into “Run Program” mode. 

 

The thermostat is in “Green / Energy Save” mode and user changes operating mode 
(heat / cool / off) on a g! UI: 

1) Thermostat is put back into “Normal” mode, and begins using the normal set point. 

2) g! puts the thermostat into “Run Program” mode. 

 

The thermostat is in “Green / Energy Save” mode and user changes operating mode on the 
thermostat: 

1) Thermostat puts itself back into “Normal” mode, and begins using the normal set point. 

2) g! puts the thermostat into “Run Program” mode. 

(Wayne Dalton only) 

 

The thermostat is in “Green / Energy Save” mode and user changes set point on a g! UI: 

1) Thermostat stays in “Save Energy” mode. 

2) The set point changes as desired. 

3) g! stays in “Permanent Hold” mode. 

 

The thermostat is in “Green / Energy Save” mode and user changes set point on the thermostat: 

1) Thermostat stays in “Save Energy” mode. 

2) The set point changes as desired. 

3) g! stays in “Permanent Hold” mode. 


